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Introduction The filtering reference design provided in the DSP Development Kit, 
Stratix II Edition, shows you how to use the Altera® DSP Builder for 
system design, simulation, and board-level verification. DSP Builder is a 
digital signal processing (DSP) development tool that interfaces the 
MathWorks industry leading system-level DSP tool Simulink with the 
Altera Quartus® II development software. DSP Builder provides a 
seamless design flow in which you can perform algorithmic design and 
system integration in the MATLAB and Simulink software and then port 
the design to hardware description language (HDL) files for use in the 
Quartus II software.

Using DSP Builder, you can generate an register transfer level (RTL) 
design and an RTL testbench from Simulink automatically. These files are 
pre-verified RTL output files that are optimized for use in the Altera 
Quartus II software for rapid prototyping. The built-in DSP Builder 
SignalTap® II Analysis block allows you to capture signal activity from 
internal Stratix II device nodes, while the system under test runs at 
system speed in hardware. You can import the SignalTap II data into the 
MATLAB workspace for further analysis. This development flow is easy 
and intuitive even if your experience designing with programmable logic 
design software is not extensive.

The lab demonstration uses the following items:

■ Altera numerically controlled oscillators (NCO) Compiler 
MegaCore® function

■ Altera finite impulse response (FIR) Compiler MegaCore function
■ DSP Builder with the SignalTap II logic analyzer read-back feature
■ ModelSim®-Altera, ModelSim PE, or ModelSim SE software
■ Quartus II software version 4.1 Service Pack 2
■ Stratix II EP2S60 DSP development board

Figure 2 shows the top-level schematic for the filtering reference design. 
Two NCOs generate a 1-MHz sinusoidal signal and a 10-MHz sinusoidal 
signal respectively. The signals are added together on-chip before they 
pass through a digital-to-analog (D/A) converter on the Stratix II DSP 
board. The resulting analog signal is looped back to an analog-to-digital 
(A/D) converter on the board and then passed to an on-chip, low-pass 
filter with a cut-off frequency of 3 MHz. The low-pass filter removes the 
10-MHz sinusoidal signal and allows the 1-MHz sinusoidal signal 
through to the fir_result output.
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Stratix II Filtering Lab
When you install the software from the DSP Development Kit, Stratix II 
Edition CD-ROM, the design files are installed in the directory structure, 
as shown in Figure 1.

Figure 1. Filtering Reference Design Directory Structure 

This application note comprises the following exercises:

■ Exercise 1—Review the filtering design using DSP Builder.
■ Exercise 2—Analyze the DSP Builder-generated models and simulate 

the filtering design in Simulink.
■ Exercise 3—Perform RTL simulation using the ModelSim-Altera 

simulation tool.
■ Exercise 4—Configure the Stratix II device with the filtering design 

and use the SignalTap II read-back feature in DSP Builder to capture 
data from internal Stratix II device nodes while the design runs at 
system speed. You then compare the results from SignalTap II 
analysis with the simulation results from Exercise 2 to verify that the 
design is functioning correctly.
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Before You Begin
Before You 
Begin

These instructions assume that you have already installed the software 
provided with the development kit onto your PC.

f For more information, refer to the DSP Development Kit, Stratix II Edition 
Getting Started User Guide for installation instructions.

You must have the following software installed on your PC:

■ Quartus II software version 4.1 Service Pack 2
■ DSP Builder version 2.2.0
■ FIR Compiler MegaCore function version 3.1.0
■ NCO Compiler MegaCore function version 2.2.0 
■ MATLAB version 7.0
■ Simulink version 6.0
■ ModelSim-Altera software version 5.8c or ModelSim PE or SE 

software version 5.8c or higher

The MegaCore blocks are located in a separate folder under the Altera 
DSP Builder branch of the Simulink block library. It is important to run a 
DSP Builder setup script once, following the installation of the 
MegaCores. The script updates DSP Builder for other newly installed or 
upgraded cores. 

1 You must configure and run a FlexLM license server during this 
process.

To run the setup script, follow these steps:

1. Run the MATLAB software.

2. In the Current Directory browser, browse to the directory where 
DSP Builder is installed:

<dsp_builder_install_dir>\DSPBuilder\AltLib

3. Run the script by typing setup_DSPBuilder at the MATLAB 
prompt in the workspace.

1 This application note assumes that you have installed the 
software into the default locations.
Altera Corporation  3



Stratix II Filtering Lab
Exercise 1: 
Review the 
Filtering Design

To review the filtering design, perform the following steps:

1. Run the MATLAB software.

2. In the Current Directory browser, browse to the directory 
<install_path>\stratixII_dsp_kit-v<version> 
\Examples\HW\Labs\Filtering\Exercises1and2and3. 

3. Choose Open (File menu) and select the file filter_design.mdl.

4. Review the Simulink design (see Figure 2). 

The filtering design contains a combination of OpenCore® Plus DSP 
MegaCore functions and DSP Builder blocks. The OpenCore Plus 
feature lets you test-drive Altera MegaCore functions for free. You 
can verify the functionality of a MegaCore function quickly and 
easily, as well as evaluate its size and speed before making a 
purchase decision. The OpenCore Plus feature also allows free 
hardware evaluation. The free hardware evaluation feature allows 
you to generate time-limited programming files for designs that 
include Altera MegaCore functions. You can use the OpenCore Plus 
hardware evaluation feature to perform board-level design 
verification before deciding to purchase licenses for the MegaCore 
functions. You only need to purchase a license when you are 
completely satisfied with a core’s functionality and performance, 
and would like to take your design to production.

f For more information on the OpenCore Plus hardware evaluation, see 
AN320: OpenCore Plus Evaluation of Megafunctions.
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Exercise 1: Review the Filtering Design
Figure 2. Simulink Design for Exercises 1, 2, & 3

5. Double-click the NCO_1MHz block to launch the IP Toolbench for 
the NCO Compiler MegaCore function (see Figure 3).
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Stratix II Filtering Lab
Figure 3. IP Toolbench

6. Click Step 1: Parameterize to review the parameters for the 
NCO_1MHz block. The NCO_1MHz block generates a 1-MHz 
sinusoidal signal (see Figure 4).

Figure 4. 1-MHz Sinusoidal Signal
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Exercise 1: Review the Filtering Design
The NCO block is implemented using the multiplier-based 
architecture, which reduces memory usage by using the hardware 
multipliers in the Stratix II device. Table 1 shows the parameters that 
you can set in the IP Toolbench Parameters tab.

7. Click Cancel to exit IP Toolbench when you are finished reviewing 
the parameter settings.

8. Perform the same action on the NCO_10MHz block, as shown in 
Figure 5.

Table 1. NCO Compiler Parameters for NCO_1MHz 

Parameter Value

Accumulator Precision 32 bits

Angular Precision 12 bits

Magnitude Precision 13 bits

Generation Algorithm Multiplier-Based

Architecture Use Dedicated Multiplier(s)

Outputs Single Output

Device Family Stratix II

Number of Channels 1

Implement Phase Dithering Yes

Dither Level 5

Clock Rate 100 MHz

Desired Output Frequency 1 MHz
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Figure 5. 10 MHz Sinusoidal Signal

Table 2 shows the parameters that you can set in the MegaWizard® 
Plug-In.

Table 2. NCO Compiler Parameters for NCO_10MHz   (Part 1 of 2)

Parameter Value

Accumulator Precision 32 bits

Angular Precision 12 bits

Magnitude Precision 13 bits

Generation Algorithm Multiplier-Based

Architecture Use Dedicated Multiplier(s)

Outputs Single Output

Device Family Stratix II

Number of Channels 1

Implement Phase Dithering Yes
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Exercise 1: Review the Filtering Design
The NCO_10MHz block contains the same parameter values as the 
NCO_1MHz block, except for the constant value that is fed into the 
phase increment input. This constant value determines the frequency 
of the NCO sinusoidal output. The NCO MegaWizard Plug-In 
calculates the constant value when you enter the clock period and the 
desired output frequency in the wizard. Figure 4, shows the 
calculated result for a 1-MHz sine wave at 53,687,091. The chosen 
clock frequency corresponds to the 100-MHz oscillator on the 
Stratix II DSP development board. Similarly, the desired output 
frequency of 10 MHz yields a phase increment value of 536,870,912 
(see Figure 5).

9. Click Cancel to exit IP Toolbench when you are finished reviewing 
the parameter settings.

To launch the IP Toolbench for FIR Compiler MegaCore function, perform 
the following steps:

1. Double-click the fir_compiler block.

2. Click Step 1: Parameterize to review the parameters for the 
fir_compiler block (see Figure 6). 

The FIR filter block is a 35-tap, low-pass filter with a cut-off 
frequency of 3 MHz. It is designed to filter out the 10-MHz 
sinusoidal signal.

Dither Level 5

Clock Rate 100 MHz

Desired Output Frequency 10 MHz

Table 2. NCO Compiler Parameters for NCO_10MHz   (Part 2 of 2)

Parameter Value
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Figure 6. FIR Filter Parameters

Table 3 shows the parameters that you can set in the MegaWizard 
Plug-In. 

Table 3. FIR Compiler Parameters  (Part 1 of 2)

Parameter Value

Filter Type Low Pass

Window Type Blackman

Sample Rate 10e7 Hz

Number of Coefficients 35

Cutoff Frequency 3e6 Hz

Multi-rate Filter Settings Single Rate

Coefficient Width 14
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Exercise 2: Simulate the Model in Simulink
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3. Click Cancel to exit IP Toolbench after you have finished reviewing 
the parameter settings.

Exercise 2: 
Simulate the 
Model in 
Simulink

To simulate the model in the Simulink software, perform the following 
steps:

1. Choose Configuration Parameters (Simulation menu) to set the 
Simulink simulation settings (see Figure 7).

Figure 7. Simulink Simulation Parameters

2. Start the simulation by choosing Start (Simulation menu).

Input Specification 12, Signed (A/D width)

Output Number System Custom Resolution

Bits to Keep 17 bits

Least Significant Bit (LSB) (Round) 12 bits

Most Significant Bit (MSB) (Truncate) 0 bit

Structure Parallel

Device Family Stratix II

Pipeline 1

Data Storage Logic Cells

Coefficient Storage Logic Cells

Table 3. FIR Compiler Parameters  (Part 2 of 2)

Parameter Value
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3. Double-click the Scope block to view the filtered and unfiltered 
signals in the time domain.

4. Click the binocular icon to auto-scale the waveforms. Figures 8 and 
9 show the scaled waveforms in the time domain.

Figure 8. Time Domain Plot of adder_result_sim—Unfiltered Data

Figure 9. Time Domain Plot of fir_result_sim—Filtered Data

5. Switch to the MATLAB window.

6. To view the frequency response of the filtered and unfiltered signals, 
use the plot_fft.m file, which is included with the lab.

a. To view the unfiltered data, type the following command in the 
MATLAB command window:

plot_fft(adder_result_sim,'Frequency Response – Unfiltered Data',10e7)
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Exercise 2: Simulate the Model in Simulink
where:

• adder_result_sim is the name of the signal at the output 
of the adder

• Frequency Response – Unfiltered Data is the title 
of the plot

• 10e7 is the sampling frequency (100 MHz), which is well 
above the Nyquist frequency

A MATLAB plot displays the frequency response of the 
unfiltered data (see Figure 10).

Figure 10. FFT Response of adder_result_sim - Unfiltered Data

b. To view the frequency response of the filtered data, type the 
following command in the MATLAB command window:

plot_fft(fir_result_sim,'Frequency Response – Filtered Data',10e7)

where:

• fir_result_sim is the name of the signal at the output of 
the FIR filter

• Frequency Response – Filtered Data is the title of 
the plot

• 10e7 is the sampling frequency (100 MHz), which is well 
above the Nyquist frequency
Altera Corporation  13
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A MATLAB plot displays the frequency response of the filtered 
data (see Figure 11).

Figure 11. FFT Response of fir_result_sim - Filtered Data

Exercise 3: 
Perform RTL 
Simulation

To generate the simulation files for the filtering design example, perform 
the following steps:

1. Double-click the SignalCompiler block in your model.

2. Click the Testbench tab.

3. Turn on the Generate Stimuli for VHDL Testbench option.

4. Click Convert MDL to VHDL. SignalCompiler generates a 
simulation script, tb_filter_design.tcl, and a VHDL testbench that 
imports the Simulink input stimuli, tb_filter_design.vhd.

5. Click OK.

6. Run the simulation in Simulink to generate the input stimulus files 
by choosing Start (Simulation menu).

7. Close the filtering design file when you are finished generating the 
input stimulus files.
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Exercise 3: Perform RTL Simulation
To perform RTL simulation with the ModelSim software, perform the 
following steps:

1. Start the ModelSim software.

2. Choose Change Directory (File menu).

3. Browse to your working directory and click Open.

4. Choose Execute Macro (Macro menu).

5. Browse for the tb_filter_design.tcl script and click Open.

1 For shorter simulation times, use the ModelSim PE or SE 
software version 5.8c.

6. The simulation results are displayed in a waveform. The ModelSim 
waveform editor displays the signals in decimal notation (see 
Figure 12) or as an analog waveform (see Figure 13).

To display as an analog waveform, right-click on the signal and select 
Format > Analog.

Figure 12. ModelSim Waveform Editor

Figure 13. ModelSim Analog Waveform
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Exercise 4: 
Analyze the 
Results in 
Hardware

Exercise 4 covers the following actions:

1. Set up the board for hardware analysis.

2. Review the changes made to the filtering design.

3. Configure the Stratix II device on the Stratix II EP2S60 device with 
the filtering design.

4. Run SignalTap II analysis in the DSP Builder to examine the filtered 
and unfiltered data.

Set Up the Stratix II EP2S60 DSP Development Board for 
Hardware Analysis

Before performing hardware analysis, you must connect two cables to the 
DSP board: the SMA cable and the USB-Blaster™ cable. The kit includes 
both cables. To connect the cables, perform the following steps:

1. Connect one end of the SMA cable to the D/A labelled as DAC_B on 
the board.

2. Connect the other end of the SMA cable to the A/D labelled ADC_A 
on the board.

3. Connect the USB-Blaster cable to your PC and to the board’s 10-pin 
Joint Test Action Group (JTAG) header for Stratix II configuration.

After you connect the cables, connect a jumper across jumper pins three 
and four on J3 on the board. The jumper settings connect the on-board 
100MHz oscillator to ACD_A. Connect a jumper across jumper pins one 
and two on J19 on the board. The jumper settings connect the phase-lock 
loop (PLL) output clock from the Stratix II device to DAC_B (see 
Figure 14).

f For detailed instructions on how to connect the cables to the board, refer 
to the Stratix II EP2S60 DSP Development Board Data Sheet.

f For details on installing the USB-Blaster software driver on the host PC 
(located at <quartus_install_dir>\drivers\usb-blaster), see the 
USB-Blaster Download Cable User Guide.
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Exercise 4: Analyze the Results in Hardware
Figure 14. Jumper Connection for J3 & J19

Review the Changes Made to the Filtering Reference Design

To review the changes made to the filtering reference design, perform the 
following steps:

1. Run the MATLAB software.

2. In the Current Directory browser, browse to the directory 
<install_path>\stratixII_dsp_kit-v<version> 
\Examples\HW\Labs\Filtering\Exercise4. 

J3

J19
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3. Choose Open (File menu) and select the file filter_design.mdl.

4. Review the schematic design (see Figure 15).

The filtering design in Exercise 4 is the same one used in Exercises 1, 
2, and 3 (see Figure 2), except:

● The output of the adder is not directly connected to the input of 
the filter. The adder output is connected to a D/A converter and 
the filter input is connected to an A/D converter. The combined 
NCO-generated sinusoids are converted from D/A via the 
on-board D/A converters. The signal exits the board via the 
D/A SMA connector, loops back into the board through the 
A/D SMA connector, and is converted to digital by the on-board 
A/D converters before re-entering the Stratix II device.

1 If the SMA cable is not securely connected between DAC_B 
and ADC_A, you do not see a signal at the output of the FIR 
filter during SignalTap II analysis.

● The output of the adder is fed to a bitwise XOR function. The XOR 
function converts the output from two's complement format to 
unsigned integer format by inverting the MSB to add a DC offset 
of 213. This conversion is needed because the on-board D/A 
converters assume the input samples are unsigned integers.

● A register is placed after the bitwise XOR function to reduce the 
tCO (clock to output delay) of the transmit circuitry.

● A counter circuit has been added to generate a pulse every 
4,095 clock cycles after reset is asserted (see step 5).
18  Altera Corporation



Exercise 4: Analyze the Results in Hardware
Figure 15. Simulink Design for Exercise 4

5. Double-click the Counter Circuit block to view the counter circuit 
subsystem (see Figure 16). When the clken input signal is high, the 
counter circuit generates a signal count_reached that generates a 
pulse every 4,095 clock cycles. In “Run SignalTap II Analysis” on 
page 20, the falling edge of the signal count_reached is set as a 
trigger in the SignalTap II Analysis block. The minimum 
4,095 clock cycle delay ensures that the data is stable on the output 
of the on-board anti-aliasing filter, which is connected to the D/A 
converter, before the SignalTap II Analyzer begins to capture data.

f For more information on how the counter circuit is used, see “Run 
SignalTap II Analysis” on page 20.
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Figure 16. Counter Circuit

Configure the Stratix II Device

To configure the Stratix II device, perform the following steps:

1. Double-click the SignalCompiler block.

2. Click 1 - Convert MDL to VHDL. SignalCompiler generates a Tool 
Command Language (Tcl) script that you can use to run SignalTap II 
analysis in “Run SignalTap II Analysis”.

1 The design has been precompiled. You can skip the synthesis 
and fitting steps. If you choose to recompile the design, you have 
to run the IP Toolbench for all three IP blocks (2 NCO and 1 FIR) 
as shown in Exercise 1, click on the Finish button in the 
Parameterize step, and Generate in order to re-generate.

3. Click 4 - Program DSP Board. SignalCompiler takes approximately 
one minute to configure the device.

Run SignalTap II Analysis

In filter_design.mdl, to specify the falling edge as the trigger condition 
for count_reached_tap, perform the following steps:

1. Double-click the SignalTap II Analysis block. The SignalTap II 
Analyzer displays all of the nodes connected to SignalTap II blocks 
as signals to be analyzed.

2. Click count_reached_tap under Signal Name.

3. Choose Falling Edge in the Trigger Condition list.

4. Click Change. The condition is updated.
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Exercise 4: Analyze the Results in Hardware
5. Right click on adder_result_tap and select Unsigned as the radix 
(see Figure 17).

Figure 17. Specify the Radix as Unsigned for adder_result_tap

Figure 18 shows the development board.

Figure 18. SW4 & SW5 on the Stratix II EP2S60 DSP Development Board

To run the analyzer and display the results in a MATLAB plot, perform 
the following steps:

SW4 SW5
Altera Corporation  21
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1. Click Start Analysis. DSP Builder runs a Tcl script to instruct the 
SignalTap II embedded logic analyzer to begin analyzing the data 
and wait for the trigger conditions to occur.

2. Press SW4 on the Stratix II DSP development board to generate a 
pulse on the reset input signal.

3. Press SW5 on the board to assert clken and to enable the counter 
circuit. Setting the clken input signal high after generating a pulse 
on the reset input signal ensures that the trigger condition, the first 
falling edge of count_reached, occurs no sooner than 4,095 clock 
cycles after the design has been reset. This minimum delay 
requirement of 4,095 clock cycles allows the data at the output of the 
anti-aliasing filter sufficient time to stabilize before the SignalTap II 
logic analyzer begins acquiring data.

4. Click OK in the SignalTap II Analysis block when the SignalTap II 
logic analyzer finishes acquiring data. The SignalTap II Analysis 
block indicates that it has finished acquiring data by displaying the 
message “SignalTap II Analysis is complete.” Two MATLAB plots 
display the captured data: in binary format, and in the radix you 
specified. The MATLAB plots display the captured data in the time 
domain.

5. Close the MATLAB plot of the data displayed in binary format. 
Examine the MATLAB plot of the data displayed in the radix you 
specified. Zoom in on the fir_result_tap signal (see Figure 19). 
The fir_result_tap signal is a scaled version of the 1-MHz 
sinusoid.
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Exercise 4: Analyze the Results in Hardware
Figure 19. SignalTap II Signals in the Time Domain

6. Return to the MATLAB window.

7. In the MATLAB window, type the following command:

filter_design_tap_variables

This command runs a DSP Builder-generated script that reads the 
SignalTap data into the MATLAB workspace.

8. To view the FFT of the filtered and unfiltered signals, type the 
following command in the MATLAB command window:

plot_fft(adder_result_tap,'Frequency Response - Unfiltered Data',10e7)
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where:

● adder_result_tap is the name of the signal represented by 
the adder_result_tap SignalTap II block in the Simulink model

● Frequency Response - Unfiltered Data is the title of 
the plot

● 10e7 is the sampling frequency (100 MHz)

A MATLAB plot displays the frequency response of the unfiltered 
data (see Figure 20).

Figure 20. FFT Response of adder_result_tap—Unfiltered Data

9. To view the frequency response of the filtered data, type the 
following command in the MATLAB command window:

plot_fft(fir_result_tap,'Frequency Response - Filtered Data',10e7)

where:

● fir_result_tap is the name of the signal represented by the 
fir_result_tap SignalTap II block in the Simulink model

● Filtered Response – Filtered Data is the title of the 
plot
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Exercise 4: Analyze the Results in Hardware
● 10e7 is the sampling frequency (100 MHz)

A MATLAB plot displays the frequency response of the filtered data 
(see Figure 21).

Figure 21. FFT Response of fir_result_tap—Filtered Data

10. Compare the plots generated in steps 8 and 9 with the plot 
generated in step 6 of “Exercise 2: Simulate the Model in Simulink” 
on page 11. The hardware results match the Simulink simulation 
results, with the exception of the impulse at frequency 0 in the plot 
of the unfiltered data. The impulse at frequency 0 occurs as a result 
of the DC offset added to the output of the adder (see the second 
bullet in step 4 of “Review the Changes Made to the Filtering 
Reference Design” on page 17 for more details).
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Troubleshooting This section contains the following troubleshooting information:

■ Why do I get errors when I load the Simulink filter_design.mdl 
design?

■ Why is my SignalTap II filtered signal different from the one 
Figure 19 shows?

Why Do I Get Errors When I Load the Simulink filter_design.mdl 
Design?

In order to load the filter_design.mdl successfully, you must have the 
correct versions of the DSP Builder, MATLAB/Simulink, and IP cores. 
Refer to the section “Before You Begin” on page 3 for details. 

Why My SignalTap II Filtered Signal Different From the One 
Figure 19 shows?

If the SMA cable is not securely connected between DAC_B and ADC_A, 
you do not see a signal at the output of the FIR filter during SignalTap II 
analysis.
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